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This workshop is designed to give an example of how to utilize Microsoft Access to create a
Form that inputs data requests into a table. The workshop will also give a few examples of how
to create reports that display selected information within a data request table. We will begin
by importing a dummy set of data that we will use as our current request database.

Step 1: Open Microsoft Access

Step 2: Select Blank Desktop
Database

Blank desktop database

File Name
Request Database SARLY

C\Users\wnpitts\Documents\
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Create

Step 3: Name the database “Request
Database SAIR 14”
Step 4: Select “Create”

e A new database will be created.
e We will need to import an existing set of data that will serve as our data request log.



Step 5: Click on the External Data tab

AN

Step 6: Select Excel
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B \%que:t Database SA

atabase- Ri\research\CONFEREMCES\2014)\SAIR)

HOME CREATE EXTER A DATABASE TOOLS
] . E'_] 5 Text File ™™
X Hj =k B
& E EEXMLFile
Saved Excel Access ODBC _] Saved
Impaorts Database |5 More~ Exports
Import & Link Export
A” ACCQSS O Import Excel spreadsheet
Search Import data from or link to datain a
cartti. Microsoft Excel file.
[ ]

This will bring up a window for you to browse and find your Excel spreadsheet,

containing our request log. This document should be saved on your desktop and named

“Original Request Database”.

.
Get External Data - Excel Spreadsheet

P |

Select the source and destination of the data

Specify the source of the definition of the objects.

Eile name: | g\ research\,COMFERENCES\2014\SAIR)Access ‘Workshop\Qriginal Request Worksheet.udsx

Specify how and where you want to store the data in the current database.

@ Import the source data into a new table in the current database.

If the specified table does not exist, Access will create it. If the specified table already exists, Access might overwr|
contents with the imported data. Changes made to the source data will not be reflected in the database.

") Link to the data source by creating a linked table.

Access will create a table that will maintain a link to the source data in Excel, Changes made to the source data i
be reflected in the linked table. However, the source data cannot be changed from within Access.

T~

Step 7: Browse and find the file
named “Original Request
Database”, then click OK.

1

o« ||

Cancel




e We will go through a few steps to import the spreadsheet.

Step 8: Be sure that this check

—

[ 58 import Spreadshet Wizard / box is checked, then click Next. B < )
-2 mpD prea ENes IZar:

Microsoft Access can u
row specified

r column headings as field names for your table. Does the first
column headings?

[Z[First Row Contains Column Headings

Reqg # |[Date In Due Date Date Out Type Eequester's Hame Egcquester's Depar
1 IRO001 1171272013 (1171272013 [11/12/2013 [Internal [Poug Reynolds L
TIROOOE M1/13/2013 1/15/2014 [1/10/2014 [External Richard Dawvid BRTTP
?IROC'OE l1/12/2013 [11/20/2013 1/15/2014 [Internal [Dr. Spurs WELD
TIRDOD‘J 11/13/2013 [11/15/2013 11/13/2013 [Internal [Dr. Helio EEL
| s TROOOS L1/13/2013 11/13/2013 [11/13/2013 Internal Bonnie Billy niversity Commun
:;IROOOE l1/4/2013 [@L1/729/2013 11/22/2013 [Internal Harry McCorkle ducation Technol
TIRODO'? n2/4/2013 [12/4/2013 [2/4/2013 [Internal Hello Kitty d Tech
| & TrRooO8 p2/3/2013 [1/3/2014 12/4/2013 [External [Tammy Carter CHE
| o TrRooOS f2/2/2013 [L/3/2014 L/a/2014 External Brandy Rich ACS Institutiona
l1oftroo010 f1/13/2013 L/15/2014 [/15/2014 [Internal Dr. Poker rt
l11[TRO0O11 p1/1/2013 [L/15/2014 Q/7/2014 Internal [Dr. Tones u=ic
[12|tRO012 Pp1/26/2013 1/16/2012 [1/16/2014 [Internal oy Borah ocial Work
l1sltro013 hz/20/2013 p/1a/2014 /772014 Internal iztance Learning
EIROO.’L& l2/20/2013 /1472014 [/10/2014 [Internal [Dr. Helio IRPR
€[ »

y

e This step translates the first row of our spreadsheet into Column headers.
e If you are importing a spreadsheet into Access, it is important to ensure that you do not
have more than one row of column headers.



e The window below allows us to specify the data type for each field in our dataset, once
we import them into access as a table. We will need to change 2 fields’ data types.

Z:‘:| Impart Spreadsheet Wizard [&J

You can specify information about each of the fields you are importing. Select fields in the area below. You can then modify field
information in the 'Field Options' area.

Field Options
Field Mame:  File Location El
Indexed: Mo
Lang Integer
Currency
Hotes: glonﬁ:je File Location
= 281PT Gr = 657TOTRAL = 6931TOTAL F|pate with Time F85 -
Short Text
rate the report. Long Text

Hyperlink

Bth of january.

s [RER[E[s]e o[ ]o o] oo ]-

Cancel | | < Back | ’ Mext = l |_ Finish |

Step 9: Scroll over until you see
the field “File Location” and
change the Data Type to
“Hyperlink”. You may also
change the field “Requester’s
Step 10: Select the first field Email” to Hyperlink.

“Req#” and under the “Indexed”
option, Select “Yes (no
duplicates)”. Then click Next.

e We want to index the field “Req#” because that field will be our unique identifier. Also,
we do not want any duplicates for this field, for obvious reasons.

e We chose to change the field “File Location” to a hyperlink, because we will link our final
report for each request (if possible) from where it is stored on our computer or shared
drive to the database.



Step 11: Choose “No primary key.” and click Next.

=] Import Spreadsheet Wizard P g
Microsoft Access recommends that you define a primary key our new table. A primary key is used to
= uniguely identify each record in your table. It allows you jerfetrieve data more quiddy.
1 e
.
g o () Let Access add primary key.
QRN 5 ¥ KA (7) Choose my own primary [=]
o primary key.

Reqg # [Date In Due Date Date Out Type Reguester's Name Requester's Iﬁpar'
|1 fRO0OOL n1/12/2013 11/12/2013 11/12/2013 [Internal [Doug Reynolds R -
2 [RO00Z [11/13/2013 [1/15/2014 [1/10/2014 [External Richard David RATP
?IROOOS fi/19/2013 N11/20/2013 1/15/2014 [Internal pPr. Spurs JERL
TIROOO4 M1/13/2013 11/15/2013 [11/13/2013 [Internal [pPr. Helio [CIRPR
EIROOOS l1/13/2013 11/13/2013 [11/13/2013 [Internal Bonnie Billy Oniversity Commun
6 [RO0OO6 [11/4/2013 [11/29/2013 [11/22/2013 [Internal Harry McCorkle Educationf Technol
TIROOOT n2/4/2013 [12/4/2013 [12/4/2013 [Internal Hello Kitty Ed Tech
[ trooos h2/3/2013 p/3/2014 l2/4/2013 [External Tammy Carter B.CHE
EIROOOQ lz/2/2013 [/3/2014 L/9/2014 External Brandy Rich IBACS Inftitutiona
10[IR0O010 [11/13/2013 1/15/2014 [1/15/2014 [Internal Dr. Poker Bre
[11jtrRo011 f1/1/2013 f/15/2014 [/7/2014 Internal Dr. Tones Music
EIROOJ.Z Ni/26/2013 1/16/2014 [1/16/2014 [Internal [Joy Borah Foci
EIROOJ.S nz/20/2013 /1472014 [B/7/2014 MInternal Distfince Learning
14[IR0014 [12/20/2013 [2/14/2014 [/10/2014 [Internal Dr. Helio CIRFR -
<« [ ( G

Cancel ] [ < Back ] [ Next = ] [ Finish
h
E] Import Spreadsheet Wizard @

That's all the information the wizard needs to import your data.

Import to Table:
Request Database

Step 12: Name the Table “Request
Database” and click the Finish button.

[ T would like & wizard to analyze my table after importing the data.

o] [ <o

e Our dataset should now be imported and ready to use.



Creating a Form to Enter New Data Requests

e We need to create a form that will allow us to enter new data requests and edit
information regarding all data requests as they are updated and completed.
e We will utilize the Form Wizard to create a Request Database Form.

Step 1: Select the CREATE tab and then
select Form Wizard.

/

h HOME CREATE

= Request Database SAIR14 : Database- Ri\research\C
EXTERMAL DATA DATABASE TOOLS

'j Request Database

Application  Table Table SharePoint  Query Query Form  Blank Report Blank
Parts ~ Design  Lists~ Wizard Design Design Form [ More Forms - Design Report
Templates Tables Clueries Forms Reports
All Access Obje... ® «
Search. yol
Tables S

Oy{ NCES\2014\SAIR Access Workshop'\Rg

D ‘=== D lm\ ﬁ m D I3 Form Wizard \ﬂ j 5] Report

Mavigation =

e The Form Wizard window will magically appear.

-

Form Wizard

Y

Which fields do you want on your form?

You can choose from more than one table or query.

Tables/Queries

Table: Request Database

Available Fields:

Date In
Due Date

Date Out

Type

Requester's Name
Requester's Department
Requester's Email

[=]

Selected Fields:

This first screen allows us to
select which of the fields in the
selected Table or Query that we
would like to populate our
Form. We want all of the
available fields in our Form.

Step 2: Select the >> button to
bring in all fields.




Form Wizard

Which fields do you want on your foarm?

You can choose from more than one table or query.

Tables/Queries

Table: Request Database E|

Step 3: Once all fields are selected,

Available Fields: Selected Fields: click Next.

| |Requester's Email

! Requester's Phone
Request Description
* | Azsigned To:

- Completed By:
= Hours to Complete:

Motes: |:

Form Wizard 1

What layout would you like for your form? Here we can decide the basic

layout type of our form.

(%) Columnar
(") Tabular
(%) Datashest

Step 4: Select Justified, then click

Next.
L

Cancel ][ < Back ][ Next > ][ Finish




Form Wizard

Request Form”.

Step 5: Title the form “Data

2

What title do you want for your for

Data Reguest Form

That's all the information the wizard needs to create your
form.

Do you want to open the form ar modify the form's design?

(@ Open the form to view or enter information.

() Modify the ian.

Step 6: Be sure “Open the form...”
is selected, then click Finish.

Cancel ] [ < Back
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e Below is the form we have created. Asyou can see, there is a lot to be desired in terms
of presentation i.e. formatting.

B HE &
HOME | CREATE

E &% cut

ER Co
View  Paste P
- Format Painter
Views Clipboard [+

Search.. re
Tables P
3 Request Database
Forms

B Data Request Form

»

Form View
e ’

All Access Obje... @ « I

EXTERNAL DATA DATABASE TOOLS

Y 4| Ascending

%l Descending  To] Advanced -
Fiter 9 i
Remove Sort

Y Selection - > Totals
P
¥ Spelling
X Delete ~ ] More

Records Find

H 23c Replace

2 GoTo~

in 3 T U
[% Select~ Bl

@ =1 New
o Save
Refresh
Toggle Filter | [~
Sort & Filter

Text Formatting
2] Data Request Form

Request Database SAIR14 : Database- R:\research\CONFERENCES\2014\SAIR\Access Workshop\Request Database SAIR14.acedb (Access 2007 - 2013 file format) - Access

7 - 8 X

Pitts, William N. =

Data Request Form

|ja'.e n

[pue Date [pate out |

11/12/2013 11/12/2013 11/12/2013
|T‘.'ae ‘

Internal

|éeq4es:er‘s Name ‘
Doug Reynolds

|:quester‘s Department ‘
HR

|§eqjes:er‘s Emal ‘
IR0001@uni.edu

[Requester's Phone |
Record: 4 < [10f25 | » M ¥

Search

NUM LOCK

B B ®




e The Form is currently in “Form View”. In order to make edits to the form’s design and
general layout, we will be switching between these 3 Views.

___—| Step 7: Select the Home tab.
@ H l'_': Ei x atabase SAIR14 : Database- R:\res
HOME CREATE EXTERMAL DATA DATABASE TOOLS

E X cut Y ?l Ascending T Selection = ’7 =1 Mew

) ER Copy ) Z| Descending T Advanced - B Save
View Paste Filter Refres
- Format Painter Remave Sort Toggle Filter Al = < Deletg
Sort & Filter Recq
D Form View = “\
h (= —g8| Data Re

Step 8: Click on the pull-down

E Layout View L Data Request Form . .
Py arrow and Select Design View.

h(‘ Design View g p—
A

*
w

% Data Reguest Form

|3a:e n |Z)_1e Date
11/12/2013 11,

Type

Internal

Reguester's Name

e Below is the form in Design View.

EHE @ = FORM DESIGN TOOLS Request Database SAIRL4 : Database- Re\research\CONFERENCES\2014\SAIR\Access Workshop\Request.. 2 — x
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT Pitts, William N. ~
1= Logo CHY [ subform in New Windo
= Moo~ I = (7] & oz | [ & BE [[E] =5 0rem it
— . oo D 53] E . EE \ e Tit — ey o
View  Themes [&] fonts - o Aa [=] - (R il w -, Dme Add Bisting Property Tab -

- B " Image - [ Date and Time Ficlds | Sheet Order “& Convert Form's Macros to Visual Basic
Views Themes N Controls Header / Footer Tools -~
All Access Obje... ® « 2] Data Request Form \ X i «
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search. P Selection type: Form
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B RequestDatabase | |Batsinaaiest B
Forms ES ; Format | Data | Event | Other | Al
B8 Dats Request Form B Caption Data Request Form -

I petan Default View Single Form @
Lo Allow Farm View Yes b
Allow Datasheet View No
Allow Layout View Yes
Picture Type Embedded
Picture [none}
Picture Tiling No
Picture Alignment Center
1 Picture Size Mode Clip
Date Out Width 6.125"
| Auto Center ves
Auto Resize Yes
Fit to Screen Yes
Sizable
. . . Yes
In Design View, the Header, Detail = =
. No
: and Footer sections are much sath
) . L. . . . Yes
3
' REER more distinct and editing is easier |: Both Enabied
. |l{|regyfester's Department :ﬂt
- here than in Layout View. fation | Datashestan Top
. . . er Bar Yes
Each field has a Text Description TR hett  AlowEdts
T —TSpTrroTTETTng Form Only
¥ Save Solitter Bar Position Yes o

text box and a text box containing [ ——
]

that field’s data for each record.




Switch back to Layout View
It is easier to adjust the width of text boxes when in the Layout View, since you can

actually see an example of the data contained in each box.

B dE - Q- FORM LAYOUT TOOLS Request Database SAIRL4 : Database- R:\vesaarch\[li
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT
23] Ecoor- . Step 9: Select both boxes related
D HE NmamENe@EREY ) H0E Step 9: Select
o e alrems 2exf to Req# (the field name and the
Views Themes Controls Head
Al Access Obje... ® «|| 3 oat reques rom data field below).
search. £/ Data Request Form
Tables ES
EH Request Database L
Forms ES [Req# &
F2 Data Request Form (ROOOL /
To select multiple objects, select a
Date In Due Date Date Out
l 11;'12/2013| 11;'12/2013‘ 11/12/2013] bOX, hold the Contr0| key, and
|T‘.,-ae ..
internal select additional boxes.
|2=_q.4es:er‘s Name |
Doug Reynolds
EHE ©- & - FORW LAYOUT TOOLS Request Database SAIRL4 : Database- Rilrese
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT
#=Logo
Aa]l B colors- & o9
O e Nu o= aEEgev i @@ 0 .
s Themes [a]fomts- “ e | Step 10: With both boxes
Views Themes - i Controls I d h h . h
All Access Obje... © «|| 3 oaetersstrom selected, hover over the right
searc. 2| Data Request Form perimeter of the boxes until the
Tables E3
B Request Database | arrow line appears. Drag the right
Forms x| et ] .
EZl Data Request Form IRO00T perlmeter to the left.
‘)aie n ‘)JE Date ‘)RiEOJi The tOtal Width ShOUld be jUSt
11/12/2013 11/12/2013 11/12/2013 . .
IType longer than the text within.
Internal

‘;EqJESiEr'S Name

Doug Reynolds

Next, let’s adjust the height of the data text box.

[ ]
B HES- Q-
HOME CREATE EXTERNAL DATA DATABASE TOOLS

D [ colors -

View  Themes [Z] ronts -

Views Themes

All Access Obje... @ «
Search. yel
Tables x
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Forms

»

= Data Request Form

s el Aabl R EISEHEWV | Eld ..

DESIGN

FORM LAYOUT TOOLS Request Database SAIR14: Database- R:\rEsEJ

ARRANGE FORMAT

=] Step 11: Click off of the selected
_1 boxes and then select the bottom

Imagaasrts
Heal

- contrls text box.
=2] Data Request Form
Data Request Form
IR0001
- Step 12: Hover over the bottom
|3a:e n ‘J.IE Date ‘Ja:e Out i
— — | Of the text box and drag it up.
IType
|Interna| ‘
|§eqjes:er‘s Name ‘
Doug Reynolds




e If we want to make the data box the same height as the description box above it, we
should switch over to design view, where there are tools that simplify this.

Step 13: Select both fields related to Req# Step 14: Under the ‘Arrange’ tab

/ select ‘Size/Space’
7
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Now the boxes should be the
same height.

: Date In Due Date

e Switch back to Layout View.




Step 16: Select one of the date
fields (name and data box) and
make it the width that you would

@ E F’A" (-—)' @ = FORM LAYOUT TOOLS
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FO I i ke .
El Aa)l B colors- ey ’
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Step 17: Select the Design tab and
open the Property Sheet.
Step 18: Select the date box you
narrowed and copy the width Step 19: Select the other four date boxes
value found in the Property and Paste the width value in the width
Sheet. line of the Property Sheet. Then press
Enter.
e This is one of several ways to ensure equally wide boxes. This may also be accomplished
in the Design View by utilizing the ‘Size/Space’ commands.
[ ]

Let’s switch back over to the Design View (

Home tab—>View) to use this option.
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FORM DESIGN TOOLS

Request Database SAIR14 : Databal

[REATE  EXTERNALDATA  DATABASETOOLS  DESIGN  ARRANGE = FORMAT SteE 20: Select the field name and
L2 Shape Fill .
el 2 - =] the field data boxes for “Date In”
Tu A-D- === Background  Alternate
- Image = Row Color . . . .
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® ==] Data Request Form . . .
p.. @« s———— by dragging their right border
L
# Form Header : :
= |- slightly to the right.
- [pata
Date In :|Date Out
CilEmena s
o Type
i Step 21: Select all date related
=7 fields.
FORM DESIGN TOOLS Request Database 414 : Database- Ri\research\CONFERENCES\201MSAIR\Access Workshop\Request.., 7 — X
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Step 22: Under the Arrange tab, Select Size/Space and then To

This will, of course, increase the

Date Out

Due Date

width of the other date boxes to
the width of the ‘Date In’ boxes.




While they are all selected, we are going to
closer to the Request # field.

*||| # petail

move the date related boxes higher and

Step 23: Left click in one of the boxes
(The double crossed arrows should
be visible), hold down and move
boxes up to the desired position.

e Let’s explore some other options within the Size/Space toolbox.
@ = FORM DESIGN TOOLS Request Database SAIR14 : Database- R:\research\CONFERENCES\2014\SAIR\Access Workshop'\Request|
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Rows & Columns Merge / Split Move Position / Size
L@« | =1 pata Request Form B} Tofit L,
o - A T AR SRR T e oty Sheet
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* 7 Step 24: With all date boxes still ] Bl Groue R —
: i Vidth Top 1pt
selected, Select the Size/Space T S—
option. /
Step 25: Select Decrease Horizontal.
This will decrease the horizontal
distance between the selected boxes.
e Next, we need to decrease the height of several data text boxes.



Step 26: Select all boxes in the Detail
section, except the Request
Description and Notes fields.
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Step 27: Under the Arrange tab, select Size/Space and
then select To Shortest.

Insert Insert Insert

elow  Left

Row:

Data Request Form
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shortest selected box.

This will decrease the height of all
selected boxes to the height of the




Next, we need to decrease the width of most of the fields. To ensure we have the

[ J
proper width for each field, we need to see that data displayed for each field.

e Switch back over to Layout View.

@

Step 28: Select the field name and data field

sl / text boxes related to ‘Type’.

Step 29: Decrease the width of these boxes
R S — to the appropriate size by hovering over the
EicL b Aa =] right perimeter and dragging it to the left.

Step 30: Switch back to Design View

A ; . Step 31: With both Type boxes selected, drag
f these boxes up and to the right of the Req#

:5'\""—52 est Fosn | |
ﬁé boxes.

Step 32: Select all boxes related to
: / Req# and Type.

e &

Step 33: Under the Arrange tab, select the Align

== pull-down and select Top.
This will ensure the 2 fields are at equal heights.
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Step 34: Select all boxes for fields Requester’s
Name, Requester’s Department, Requester’s
Email. and Reauester’s Phone.

Step 35: Set the width to
: ] , . | 2” within the Properties
Tab.

‘Width of object

wMox B OB

e We would like to add text above the Requester related information and have it read
“Requester Information”, creatively enough.

Step 36: Under the
3 : _ - : : . Design tab, select Label.

Step 37: Insert a box

bee |——oweos /— below the Date boxes by
dragging open a box.

Step 38: Once the label box
is in place, type “Requester
Information”.




e We need to format the text that we just entered, so let’s switch over to the Layout
View.

Step 39: Make sure the new text box is
highlighted and select the FORMAT tab.

Step 40: Within the Font section of the
FORMAT tab, change the Font Size to 14
and change the Font Color to Black. Also,
Bold the text.

Requester Information

[ 1]

e We need to finish arranging the Request related text boxes. Let’s switch over to Design
View to do this.

& = FORM DESIGM TOOLS Request Database SAIR14 : Database- Re\research\CONFERENCES\2014\SAIR\Access Workshop\Request [
CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRAMNGE FORMAT
>
Size/
Space~
Rows & Columns Merge / Split Move Position Sizing & Ordering
_je... @ « |§| Data Request Form
T T T T T I - B T T
yel
a # Form Header
3
m

Step 41: Move and Arrange the fields
related to Requester’s Name, Requester’s
Department, Requester’s Email, and
Requester’s Phone, as seen here.

e Try to ensure even spacing by using the
Sl Size/Space and Align options, found
within the Arrange tab.

ue Date

te's DEparzment| i

equester's Department

- ||{|Requester's Name
2

- Request Description
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Merge / Split

Request Database SAIR14 : Database- R:\research\(

FORMAT
H i) E
Control Anchoring S|
Margins - - Spl
Move Position
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E CREATE  EXTERNALDATA  DATABASETOOLS
Tabulsr
e B Rows & Columns
ObjE‘ 5 « || 2] DataRequest Form
»
tabase
st Form
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Step 42: Move Request Description up
and increase the height of the data field.

To select only the data field, you will need
to click into the grid and then back onto
the data field before you adjust the size.

|reque

ster's Department

H

Requester's Phone

‘ieq.lasz»ar's Ji’\DTE- Hhnani

i Requester's Email

: f
| H -|%aq.¢as;4fs-£ma- s

e The text boxes for Request Description border the right edge of the page. We need to
slightly reduce the width, in order to place a rectangle (in the following step) around all

Requester Information.

: Requasterlnfnrmﬂlonr

+#

Format | pata | event | omer | an

Step 43: Select both text boxes for
Request Description.

as the width.

Step 44: In the Property Sheet enter 5.8




EHES- & = FORM DESIGN TOOLS Request Database SAIRL4 : Database- Re\research\CONFERENCES\2014\SAT

HOME CREATE EXTERMNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT

=L e L =T DY E e~ ECER Y

View  Themes [2]Fonts -

Views Themes - Controls

All Access Obje %) <« || =21 Data Request Form

[Search-. L A A S

Tables 5 || Eram tesder Step 45: Under the

£ Request Database

DESIGN tab, find and
select Rectangle.

»

Forms

75 Data Request Form

Step 46: Left click just
above and to the left of
~ Requester Information,
then drag the rectangle to
" | fitaround all requester
information.

anasidrs Rt T
:[Requester's Email

- |Sa

3' |Request Description

e Let'sincrease the Border Width of the Rectangle surrounding the requester’s data.
e Todoso, let’s switch back over to Layout View, so that we can get a better perspective
of the form’s look.

Step 47: With the

et +— Rectangle selected,
change the Border Width,
within the Property
Sheet, to 2pt.

Requester Information
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ct Layout
) A

Column

ular Remove | 1 Insert Insert Insert - Merge  Split Split Move Move Control  Control  Anchoring
Layout = Ab Below Le Right Select Row Vertically Horizontally Up Down | Marg Padding
Rows & Columns Merge / Split Move Position
bJe i « =8| Data Request Form
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yel
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Requester's Name

hone
BE

Requester’
E

's Email

Requester's P

{Request Description

Step 48: Arrange the
fields Assigned To:,
Completed By:, Hours to
Complete, as seen here.

Completed By:

Hours to Comple;

Step 49: Arrange the
fields Notes: and File
Location, as seen here.

File Location

e Save and Close the form.



e We need the text boxes for Request Description and Notes to hold more information
than they currently hold. We brought those fields in originally as “Short Text” data
types, which only hold a maximum of 255 characters. These are the fields where we
may have a lot to enter. We’ll need to change their data type to “Long Text”, which can
hold up to 64,000 characters.

@ H E = TABLETOOLS  Request Database SAIR14 : Database- Ri\research\CONFERE
HOME CREATE EXTERMAL DATA DATABASE TOOLS DESIGM

? A EE £= Tnsert Rows

2K Delete Rows

B & = B

View  Primary Builder Test Validation d'_| . Property Indexes Create Data Rename/ Relationships Object
- Key Rules ~ ESModify Lookups | Sheet Macros = Delete Macra Dependencies
Tools Show/Hide Field, Record & Table Events Relationships
D Datasheet View - 1T, |
) « j Request Database \
D pesion View g2 Field Neme S AL Step 50: Open the table
# Date In Date/Time
1 Request Database Dateln e i Request Database and
Forms # || Dateout Date/Time select the Design View
EB Data Request Form Type Short Text
Requester's Name Short Text Option .
Requester's Department Short Text
Requester's Email Short Text
Requester's Phone DT
Request Description
Assigned To: &
Completed By: Short Text

Hours to Complete: My
Notes: GrortTent)
File Location HNyee

Short Text fields only 255
characters .

General |Logkup

Field Size 255
Format

Input Mask

Caption

Default Value

Walidation Rule

Validation Text

Required No

Allow Zero Length Yes

Indexed Yes [No Duplicates)
Unicode Compression No

IME Mode Mo Control

IME Sentence Mode None

Text Align General

Design view, F6 = Switch panes, F1 = Help,




BEHE S = TABLETOOLS  Request Database SAIRL4 : Database- Ri\research\CONFERENCES\2014\5Al
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN
El ? [E/ 2= Insert Rows D ﬁ‘ D,g ,ﬁ
- 3 Delete Rows b
View rimary Builder Test Validation = Property Indexes  Create Data  Rename/ Relationships Object
- Key Rules ~ EQ Modify Lookups  sheet Macros = Delete Macro Dependencies
Views Tools Show/Hide Field, Record & Table Events Relationships
All Ackess Ob_]e ® « =H Request Database
— o Field Name Data Type
Req# Short Text
Tables " Date In Date/Time
13 Requelt Database Due Date Date/Time
Forms & Date Out Date/Time . Qj
E2] Data Refjuest Form Type Short Text Ste 51. SI m ply Cha nge
Requester's Name Short Text the Data Type from Short
Requester's Department Short Text
Requester's Email Short Text Text to Long Text for
Requester's Phone Number
Request Description Long Text fields Request
Assigned To: Short Text
Completed gy: Short Text Description and Notes:
Hours to Complete:

Notes:
File Location

Step 52: Save and Close
the table.

Long Text
Number
Date/Time
Currency
AutoNumber
Yes/No

OLE Object
Hyperlink
Attachment
Calculated
Lookup Wizard...

Field Properti
General |Lookup
Format @
Caption
Default Value
Validation Rule
Validation Text
Required No
Allow Zero Length Yes
Indexed Nao
Unicode Compression Na
IME Mode No Cantrol
IME Sentence Mode Nane
Text Format Plain Text
Text Align General
Append Only Na

Design view. F6 = Switch panes. F1 = Help,

e We want the fields Type, Assigned To:, and Completed By: to be Combo Boxes that use drop
down choices. This ensures data consistency for these fields. We need to change these fields’
data boxes from simple text boxes to combo boxes, which will enable the drop-down choices
feature.

e Let’s open our Data Request Form and switch over to the Design View.



@ H E @ A FORM DESIGM TOOLS Request Database SAIRL4 : Database- Ri\research\CO|

HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT
D n Colors =

View  Themes [] Fonts -

%Aa

ne

EMeEEld B B

Views Themes Contrals
All Access Obje... @ «| | F PataReauest Form |
Seareh ¥ R R T A AN SRR AR
areh..
Tables 2 # Form Header
'j Request Database
Forms 2 |||-
=] Data Request Form -
# Detail
Build Event...
et Bt s :
. . Change Te b | ol
.
Step 53: Right-click on b O N
the Type data field. Cut BB List Box
= Copy m Compo Box
2 N il e E Paste
° ||| Requester's Phone
i

; | Request Description Layout 4

R Align 3

- Size »

+

- Paosition 3

- Delete

Step 54: Select Change To
and then select Combo Box.

Anchoring

Fill/Back Color

Font/Fare Color

Special Effect

Conditional Formatting...

Eorm Properties

Properties

Design View

Step 55: Repeat Steps 53 and 54 for the
fields Assigned To and Completed By.

U Request Description




e Now that we have turned these text boxes into combo boxes, we need to populate the drop-
down choices with data previously used in these fields.

e To do this we will utilize a query function that groups by these fields’ current data.

e Also, as we add new data requests that may be completed by a new person, we will add to the
drop-down choices.

B HE 9 | = FORM DESIGN TOOLS Reque:
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT

D -‘-D 3 Cut

Eiy Copy
View  Paste P
. . ¥ Format Painter X Delete ~
Views Clipboard L] Sort & Filter Records Fini
AH ACCeSS Obje &) « Z2] Data Request Form
N N A D
Sgarch yel
Tables N # Form Header
2

Forms

»

EH Request Database )
@ Data Request Form

" s|Date In

< E

Requester's Phone i Requester's Email

x
=] Property Sheet x
ii'::"”""“‘ Combo Box - L~ Step 57: Select the Data Tab in the Property
Data [Went | other | anl Sheet.
Caontrol Source Type
Row Source =
Row Source Type Table/Query
i To Lt Mo \
Allow Value List Edits Yes
Tt valie Lo = \ Step 58: Click within the Row Source line.
Show Only Row Source Valug No . .
npot hlask This will generate a Query.
Default Value

Validation Rule
Validation Text

Enabled Yes
Locked Mo
Auto Expand Yes

Show Table 2 |mES

Tables | Queries IBuﬂw

Hequest Database

Step 59: Add the Request Database table to
/ the query.




B HE QUERY TOOLS Request Database SAIR14 : Database- Ri\research\CONFERENCES\2014\SAIR Access Workshop\Request Database SAIR14
HOME DESIGN

D ! D‘j E D Union E &= InsertRows | “FInsert Columns z rrlE’?] PropertySheet B_ B

- &3 Pass-Through % Delete Columns = Table Names

View Run  Select Crosstab Show M Totals Parameters Save Close
- Table i Builder 25 Return: | All A As
Results Query Type Query Setup Show/Hide Close

=¥ Data Request Form : Query Builder

Request Database

Req #

DateIn

Due Date

Date Out

Type Step 60:

Requester's
Requester's Departm
Requester's Email

Double-click or
Requester's Phone ~, .
drag the field

Comptes oy Type into the

Hours to Complete:

Hotes: bottom of the
query.

Step 61: Select the Totals
button in the Design tab.

This will allow us to Group
By the Type field.

Field: | TR EA|/,
Table: |Request Database
Total: | Group By
Sort:
Crilr:r::j (] ] ] (] (] ] [ (]
If you view this query’s results, you will see that it
returns two lines, Internal and External. These will be
the available choices in our drop-down for the field
Tvpe.
le format) - Access ? - *
Pitts, William M. ~
Step 62: Close and Save
this query by clicking the
o — Black X in the top right
~ Property Sheet x
Selection type: Feld Properties and corner of the query
box.
Format
Input Mask
Caption
Text Format

e Repeat Step 56 — 62 for the fields Assigned To and Completed By.



e Now let’s format the Header section
@ - FORM DESIGN TOOLS Request Database SAIR14 : Database- R:\research\CONFERENCES\2014\SAIR\Access Workshop\Request Database SAIR14.accdb (Access 2007
i ol NP
Vg spg"~> Step 64: Under the
Rows & Columns Merge / Split Move Position Size
bje.. © «|| T patemestiom [ [ e e | Arrange tab, select
S — - | the Size/Space pull-
Y DataR#qu o down and then
He Ert e e e . ) SelectTOFit.
j:; Grid
| Ruler
_____ H swocs
Redusst Desohiptifns oL Grouping
s/ Request Descriptign
Step 63: Switch to Design _
— View and select the text box -
found within the Header.
e Using the To Fit option fits the size of the text box surrounding the text.
- -
. =
| fhat
\
e X
Step 65: Either manually center the text box or center it
by entering 1.875 in the Left line of the Property Sheet.
e Next, let’s add a 2"9 text that will read the name of your institution and have that text
box placed above the text that reads Data Request Form.
e To do this, the easiest way will be to copy and paste the current text within the Header.
e Then we will place that text below the current text.
e Then we will alter the text on top to read the name of your institution.
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FORM DESIGN TOOLS

Request Database SAIR14 : Database- Ri\researc(\CONFER|

Step 66: Right-click on the text box and

=2] Data Request Form

EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT
) ey l:l Qlihapeﬁl\'
ek o e . IE' Shape Outline =
u . = ackground  Alternate onditional —
LAL Image~ Ro Formatting ! Shape Effects
Font Number Background Control Formatting
b « || 5] pataRequest Form
e . 2 . R . 5 . 5 . T
P
N ¥ Form Header
- Sl
“ - Build Event...
# Detail ChangeTo
Tap Order.
- Cut
e select Copy.
1 Paste
- )
| e e
- | |R ter's N Ri
;|[[Requesters Name e
Requester's Phone Req
) Align
5 | IRequest Description Size ¥ )
. Pasition »
. X Delete
. L
N } Anchoring v
N Fill/Back Color
. Font/Fore Color
N Special Effect
- Form Properties
B Properties
o |
s FORM DESIGN TOOLS Request Database SAIR14 : Database-
EXTERNALDATA  DATABASE TOOLS DESIGN ~ ARRANGE  FORMAT
El £ Shape Fill -
&- Background A\ onditional
Image~ Ro Formatting
Font Humber Background Control Formatting

F Detail i ES
Reg# [ ™
Req # &

" ~Date In

Requester:

Requester's Phone

é JRequest Description

Build Event...
Tab Order..

Paste

Fill/Back Color

Ruler

Grid
Page Header/Footer
Form Header/Foster
Form Properties
Properties

Requester's Email

Step 67: Right-click anywhere within the
Header section and select Paste.

This will add a 2™ Label to the header.
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Request Database SAIR14 : Database- R:\research\ CONFERENCES\4
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libri (Detail) <[22 +]« [Formatting El &‘ShapeFlllv
Back d It : Conditional ’:_'Shape Qutline ~
Iu - . E=E= ackground Alternate e Conditional -
A-2 Image~ Row Color Farmatting Shape Effects
Font Mumber Background Control Formatting
b ® « :__E'| Data Request Form
T B B T B AT S A [ ' 7 3
yel
N # Form Header

Step 68: Position the 2" label box below
the other.

Feel free to use the Arrange options.

N\

Step 69: Change the top text to read the
name of your institution. You'll notice that
the size of the box will adjust to fit your
next text as you type.

e Let’s switch back to Layout View to see how our changes look.

e | believe it would look better if the Header’s background color was white and if the text

within the Header was darker.

B HE S @ = FORM LAYOUT TOOLS
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT

11 [FormHeader - Formatting D

Request Database SAIR14 : Database- Ri\research\CONFERENCES\2014\SAIR\Access Worksh|

Shape Fill »

Autematic

H EHEN m
-

White, Background 1

Requester Information

[Requester's Name | ARequester's Department |

Doug Reynolds HR

IR0001@uni.edu

& . Background Altemate  Quick Chang
Ts Select All Q Image~ Row Color Styles - S
Selection N Font MNumber Background
All Access Obje @« Z=] Data Request Form
searcn. £ The University of North Alaba
Tables £
T Request Database Data Request Form
Forms A b —
= Data Request Form Req # [Type
IR0001 Internal [~
ba:e n |3.JE Date ‘
11/12/2013 11/12/2013; 11/12/2013

Standard Colors

@ More Colors..

Step 70: Under the Format
tab, Select the Shape Fill
pull down and choose
White.

enewal update
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i -| | catibri (Detain -l - D ?ShapeF\H'
L# Shape Outline -

T Select All BIU A-D. === Background
Image ~
Selection W 20Ngstic Number Background Control Formatting

. The Col
All Access Obje... @ « =™ 2®
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" mEm ] ; ;

Jgerch- ' University of North Alabama
Tables EY Black, Text1

E8 Request Database ] Data Request Form

o Tty T q

== Data Request Form Srrrlinre

:lIIIIIE

u [puepate N\ [Date out
u
EEE
EEEEEEEEEE
T CETTT ik
Recent Colors
n
& More Colors..

11/12/2013 11/12/2013

Step 71: Select both boxes
of text within the Header
and select Black as the Font
Color.

e Now let’s spruce up this Header by adding a couple of images on both sides of the text.
To do this, we’ll need to switch back over to Design View.

xvz n .
abl]| Aa =28 i il : V| e . M a0

" Shest O

The University of North Alabama
Data Regquest Form

i / \
Step 72: Click within the Step 73: Under the Design Tab,
blank space of the Header. Select the Insert Image pull-down
and select Browse.

4

e Browse and find the file named Torch.jpg.

BHE S Q- FORM DESIGN TOOLS
HOME ~ CREATE  EXTERNALDATA  DATABASETOOLS  DESIGN  ARRANGE  FORMAT

D I]Culurz' hAaD%Em’u

View  Themes [&] Fonts -

Step 74: Once selected, a cross-hair
with the image icon will appear.
Drag this image across the space to
= | the left of the titles in the Header.

Controls |

Views Themes

plinccess 001, .| Step 75: Copy and Paste this image to
Tables IS

the right of the header’s text and
Arrange these 2 images to be equal
sizes and distances from the Header’s
text.

EH Request Database
Forms %
Z= Data Request Form




e Switch back over to Form View to see the changes we have made to the form.

BEdE 8 Request Database SAIR14 : Database- R:\research\CONFERENCES\2014\SAIR\A
HOME | CREATE  EXTERNALDATA  DATABASE TOOLS
E X cut Y 5| Ascending Y Selection ~ @ & New Totals H 30 Replace
R Copy | Descending T Advanced - Hsave % Spelling 2 GoTo~
View | Paste Filter efresh Fin
. Format Painter Remove Sort ¥ ToggleFilter  pyj+ X Delete ~ [ More Iy Select~
Views Clipboard ) Sort & Filter Records Find Text F
All Access Obje @ « || == DataRequest Form
Search. 5 5 The University of North Alabama 5
Tables 2
S Request otabose T Data Request Form T
Forms E3
= DataRequest Form ’T‘ ’mg—‘
internal_[+]
[aten | [pue pate | [pate out |
11/12/2013 11/12/2013| 11/12/2013
Requester Information
[Requester’s Name | [Requester's Department |
Doug Reynolds HR
[Requester's Phone | [Requester's Emai |
2567650001 [IRO0OL@uni.edu
[Request Description
Professional liability insurance renewal update
[Assigned To: ] Completed By: | Hours to Comple]
my mv
[Notes:
Fall 2013: FT Und = 4852PT Und = 1141FT Gr = 281PT Gr = 657TOTAL =
6931TOTAL FTE (FT+(PT/2)) =5785
[File Location |
Record: 4 ¢ [Lof25 | » W ¥ Search

e If you click within the Req# data field and then TAB through you’ll notice that the order is
somewhat off.

e We can easily change the order that the form TABs through.
e Let’s switch back over to Design View to make these Tab Order changes.

Step 76: Select the Design tab
and then select Tab Order.

The Tab Order window will ) e e
appear.




r

Click to select a row, or
dick and drag to select
multiple rows. Drag
selected row(s) to move
them to desired tab
order,

Tab Order
I Section: Custom Order: I
Form Header Req #
Detail
Form Footer Type
Date In
Due Date

Date Out T
sters Mame

Requester's Department
Requester's Phone
Requester's Email /
Request Description
Assigned To:

Hours to Complete:
Notes:
File Location

¥

o] |

Cancel l[ Auto Order ]

Step 77: Either manually adjust
the order by left-clicking the box
to the left of those fields out of
order and dragging them to their
correct position OR simply click
Auto Order.

t

\CONFERENCES\2014\SAIR\Acce

5 ‘WThe University of North Alabama 5
T Datai Reduest form I Step 78: Switch back over to
& B Form View and Tab through the
s fields to ensure the order is

correct.




ADDING A NEW DATA REQUEST

e Now that the Data Request Form is complete, let’s go through the steps of adding a new data
request.

o When we add the new request, this process will add a new record to the Request Database
table.

»
-

Forms
% Data Request Form

|T-_,- pe |

] Internal E
2/7/20 2/7/2014 2/7/2014]
Requester Inforfation
|::eq.1es:er's MName \ | |::eq_1es:er's Department |

Hello Kitty Ed Tech

Requester's Emai |
2567650025 |

|:.eq uester's Phone

|::eq.1es: Description
MNumber of physical bodies in all courses

Step 1: Within the Record line at
the bottom of the form, select
the Last Record by clicking on
the Last Record Button (>]).

|Ass'g'|ed To: | |C-3"1:| eted P |

mv =l mv 2
|‘\ otes:

The number is 27,062

This will take us to the last
record in the dataset, IR0025.

|:/_-3ca:'-3 n J |
‘ M record

Record: 4 4 [250f25 | ¥ W FI[ T Search

Form View

e We want to keep the request numbers in Alpha-numeric order. Our next data request ID should
be “IR0026”.



The number is 27,062

Mext record
Record: M 4 |250f25 | B M F T Search

Step 2: Click the right arrow
button(Next Record) to take us
to a new record, where we will
input the new data request.

e Enter the following data into the blank record:

Field Information to Input
Reg# IR0026
Type Internal
Date In 2/10/2014
Due Date 2/24/2014
Date Out Leave Null
Requester's Name Bobby Charles
Requester's Department | Music
Requester's Phone 2567650026
Requester's Email IR0026@uni.edu
Request Description Spring 2014 Music Majors by Class Level
Assigned To: mv
Completed By: Leave Null
Hours to Complete Leave Null
Notes: Leave Null
File Location Leave Null



mailto:IR0026@uni.edu

The record should look like the image below:

&

CREATE

BHES-
HOME

E Cut
View Paste —or
- Format Painter
Views Clipboard ]
All Access Obje... @ «
Search.. ys)
Tables 3
E:j Request Database
Forms 3

E Data Request Form

Request Database SAIR14 - Copy : Database- R:\research\ COMFEREMCES

EXTERMAL DATA DATABASE TOOLS
Y ?l Ascending Y- Selection - T = New z Totals a Replace
%\l Descending T@Advancad' EHSEVE ‘5 Spelling 2 GoTo~
Filter Refresh Find B I U
Remove Sort Toggle Filter All~ Delete = Mare [ Select~ i
Sort & Filter Records Find

iﬂ Data Request Form ',

5 The University of North Alabama
T Data Request Form

3

|

‘Req # | |Tvpe |

IR0026 internal  [=]

‘Da‘.e n | |D'JE Date |
2/10/2014 2/24/2014 =

Requester Information

‘Reques’.er's Name | |F<eques’.er‘s Department |

Bobby Charles

Music

‘Reques‘.er's Phone

2567650026

|Requester‘s Ema |
IR0026@uni.edu

‘Reques‘. Description
Spring 2014 Music Majors by Class Level

|Ass'gned To: | |C0mp eted By: | Hours to Complete:

mv |Z|

|\DTES:

|:' e Location ‘
Record: M 4 |26 0f26 | » M} Search

Form View

Now we have entered a new data request and this request and that information is now

saved in our Data Request table.
Let’s move forward in time, to the time when we have completed the request, so that
we can go through the steps involved in logging out the request and mapping the final

file serving as the completed request.



BHE S & - Request Database SAIRL4 - Copy : Database- Ri\research\CONFERENCES\2014
HOME CREATE EXTERNAL DATA DATABASE TOOLS
E Cut Y T Selection ~ @ = New > Totals H 30 Replace
. . T 2] v
Copy g ] A d + o S Spelli 2 GoTo~
View | Paste ! Filter 9 LelAdvnce Refresh = voeelng g °re I u
- Format Painter Toggle Filter  pj+ X Delete = 5 More [ Select~
Views Clipboard 2 Sort & Filter Records Find
AH Access Obje @ « 5] Data Request Form
Searen.. o 5 The University of North Alabama 5
Tables ES
B Request Database T Data Request Form T
Forms ES

EE Data Request Form

4 Req # Type
IR0026 Internal [~
|3a:e n ‘ |3Je Date ‘ ‘Ja:e Out ‘
2/10/2014 2/24/2014 2/23/2014

Requester Information

|=que;ter's Name ‘

‘%;qJester‘s Department |
Bobby Charles

Music

|§eqjesier's Phone ‘

2567650026

‘ieqﬁ,sier‘s Emal |
IR0026@uni.edu

|2ques: Description

Spring 2014 Music Majors by Class Level

Step 3: Enter the following data:

Date Out: 2/23/2014
Completed By: mv
Hours to Complete: 1
Notes: All 2" Bachelors
were grouped in Senior
class level.

|»’xss gned To: ‘

mv

|C-:*13 eted By: ‘
mv

|'\-::es:

\All 2nd Bachelor's were grouped in Senior class level.

|:' e Location

Record: 4 4[260f26 | b M b Search

Form View

Lastly, we need to map the completed file, within the File Location section.
There is a file named IR0026 (check your desktop) that we will use as our completed

request.




@ = Request Database SAIR14 - Copy: Database- Ri\research\CONFERENCES\2014\SAIR\Access Workshop\Request Datalf
EATE EXTERNAL DATA DATABASE TOOLS
Y g Y Selection - @ = New 2 Totals 2L Replace
ding T - H - -
scending T Advanced Hsave 3 Spelling 3 GoTo
Filter : Refresh BT U
Painter Remo: ToggleFilter | ap- 2% Delete - [ More [ Select~
£ Sort & Filter Records Find Text Formatting
& « || Z3 Data Request Form |
» 5 The University of North Alabama 5

Data Request Form

I

»

f

Requester Information

‘Raq # | |T-.,'pa |

IR0026 internal  [~|

‘Da’.e n | |Due Date | |Daie Qut
2/10/2014| 2/24/2014) 2/23/2014

|Reques'.er's Department

‘Reques:er's Name

Bobby Charles

Music

|Requester's Email
IR0026@uni.edu

2567650026

‘Requester's Phone

Step 4: Right-click within the File

‘Requesi Description
Spring 2014 Music Majors by Class Level

Location data box.

% Cut
By Copy
‘Ass'gned To: | |Cnr‘1p eteg/By: ‘
mv mv B
‘\o:es:
All 2nd Bachelor's were groupeg/in Senior class let
Text Filters
Equals Blank
Does Mot Equal Blank
< Delete
Hyperlink

‘:' e Location

¥

Step 5: Select Hyperlink, then
select Edit Hyperlink...

% Edit Hyperlink...
Open Hyperlink
Open in New Window
Copy Hyperlink

Add to Faverites...

Record: 4 426026 | » M b Search
R Remove Hyperlink

e A browse window will appear.
r ™
Insert Hyperlink m
Link to: Text to display: C\Users'wnpitts'\DesktopIR0026.x]s5x
Look in: B Desktop = 'Et"i
Existing File | EI - D
or Web Page Izl_] Internationals Request -
S— Current IZI__] IRO026
Folder ] i ) )
| Microsoft Office Step 6: Find and select the file
E-mail S . . i
Address | | Browsed | o 'Nathan Pitts - Curriculum vitae named IR0026, then hit OK.
e ] Mation Codes
% 85| Mew Transfer Retention
Hyperlink Regent 0| Requests database - Shortcut
Builder Files m Rezume
#] Songs
Address: ChUserstwnpitts\DesktopIR0026 xlsx
’ OK l [ Cancel
e




|:ile Location

C:\Users\wnpitts\Desktop'IR0026.xIsx

Record: 4 4 |26 0f26 | » 2 Search

The file is now mapped to the data request.




CREATING REPORTS TO ANALYZE OUR DATA REQUESTS

e Being able to create reports based on our Request Database table is a great tool. One very

useful report is an Outstanding Data Requests report, which will allow you to view what data

requests that have yet to be completed.

® You can also create reports that allow you to see what reports have been completed within
certain time frames (i.e. within the past 2 weeks) or what reports have been completed by

specific individuals.

e We will begin by creating the Outstanding Data Requests report.

® Reports may be built on Tables or Queries. Since we need to limit our report to only those
requests that are outstanding, we will need to create a query that displays all of the data for

only those requests yet to be fulfilled.

B HE =
HOME = CREATE  EXTERMALDATA

Query Query gorm  Form  Blank
Wizard Design esign Form [= More Forms -
Queries orms
1 - =8| DataF i
All Access Obje... @ «|| = 2=f Query Design

Request Database SAIR14 : Database- Re\research\CONFERENCES\20144SA

DATABASE TOOLS
I E& Form Wizard T i3l Report Wizard ¢ Module
BE M BeE EECZ ] [] 3 N
. X = Navigation ~ Labels © I Class M
Application  Table Table SharePoint Report Report Blank Macro
Parts - Design  Lists~ Design Report 2] visual B

Reports

Macros & Cod

Templates Tables
Create a new, blank query in Design
search.. A /0 Alaban
Tables £
8 Request Database ou can then use the Show Table equest Form
dialog box to add tables or queries
to the query design.

Forms
% Data Request Form

»

Step 1: Under the Create tab and
within the Queries section,

Requester Information

‘::ques:er's Name

‘Req.les:er's Department |

Doug Reynolds

HR

‘::ques:er's Phone

2567650001

‘ieq.les:er's Emai

IRD001@uni.edu

Req# | [Type | select Query Design.
IR0001 internal  [~]
‘Da:e n |3.l-2 Date | ‘38:2 Qut ‘

11/12/2013 11/12/2013 11/12/2013

Form View

Request Description

Professional liability insurance renewal update

|Ass gned To: | |C-:'1a eted By: | Hours to Complete:

my |Z|

mv

|'\D:ES!

Fall 2013: FT Und = 4852PT Und = 1141FT Gr = 281PT Gr = 657TOTAL =
6931TOTAL FTE (FT+(PT/3)) = 5785

|:'E_DCR'. on ‘

Record: M 1 of 26 L

Search



Show Table

Tables

Queries | Both

Step 2: Click Add to add the
Request Database table to the
guery, then hit Close.

Add

Close

@ d l:»:‘ - QUERYTOOLS  Request Database SAIR14 : Database- Ri\research\CONFERENCES\2014\SAIR\Access Workshop\Request Database SAIR14.accdb (Access 2007 - 2013 file format) - Access
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN
D ] D——‘ \:l +! /I E l ?}Umvn + ?z Insert Rows. ‘iﬁ:‘[nsentv\umm Z rr.E7 EPrvp:rwSh:ﬂ
i & Pass-Through %' Delete Columns B Table Names
View Run  Select Make Append Update Crosstab Delete . Totals Parameters
- Table £ Data Definition 280 Return: | All -
Results ~ Query Type Query Setup Show/Hide
All Access Obje... © «|| B oo reauestrom {51 cuenrt x
Search.. o Request Database
Tables EY H H H
B reqvet o Step 3: Bring all fields down into the query.
B DataRequest Form Due Date
.
Step 4: In the Criteria line of the Date Out,
type Is Null.
This will limit our results to only those records
where there is no date out (not completed).
< » B
/
Field: | Req# DateIn Due Date Date Qut Type Requester's Name Requester's Departm¢ Requester's Email Requester's Phone | Request Description | [Assigned To:] [Com
Show:
Criteria: Is Nl |

e Now run the query.



= Request Database SAIR14 : Database- Ri\research\CONFERENCES\2014\SAIR\Access Workshop\Request Database SAIR14.accdb (Access 2007 - 2013 file format) - Aceess

EXTERNALDATA  DATABASETOOLS
Y lAz(Eﬂdmg VTJSE‘E(UEIH' EIBNEW ETnta\z 5 Replace Calon T
4l Descending T2l Advenced - Hsave 7 spelling 3 GoTo
fier Ri‘rf; X Delete ~ [ More~ Find Bocear B 1Y A~ - d- =
o Sort & Filter Records Find Text Formatting n
« || B Quent\F Request Database
Req# - Dateln - DueDate - DateOut -| Type - Requesters - Requester's - Requester'sEmail - Requester's - RequestDes~ AssignedTo - Completed - HourstoCor-| Notes: - |FileLocatior -
f) 116/2004  2/21/2014 External Kenny Kennett Peterson's und IR0016@uni.edu 2567650016 Complete 2013 my/np
- 1RO0L7 1/16/2014 3/7/2014 External Kenny Kennetf Peterson’s fina IR00L6@uni.edu 2567650017 Get informatio |h
1ROD19 11602004 3/21/2014 External LanaGivens  Open Doors Su IR0019@uni.edu 2567650019 2014 Open Doc np
* 1R0020 1/16/2014 4/aj2014 External Levi Thompsor Wintergreen O IR0020@uni.edu 2567650020 Wintergreen O mv

*

The query returns 4 records. These are the
data requests that are yet to be completed.
We will need to save this query and base our
report on it.

e Save the query as Outstanding Data Requests, then close it.

® .

Request Database SAIR14 : Database- Ri\research\CONFERENCES\2014\SAIR\Access Workshop\Reqg

HOME CREATE EXTERNAL DATA DATABASE TOOLS
L [ [ Form Wizard E i | 13 Report Wizard % Module

EE N EE Eg0° ] [ ]

— \ Navigation = 21 Class Module
|Application  Table Table SharePai Query Query Form  Blank Report B, Macra )

Parts ~ Design  Lists~ \Wizard Design Design Form More Forms ~ Design JEport =|Visual Basic
Templates Tables ) Forms Reports Macros & Code
All Access Obje... @ « Report Wizard

Show the Report Wizard which
Search. P helps you to create simple,
Tables % customized reports,

j Request Database

Queries Fy

B3 Outstanding Data Requests
Forms S

§1 Data Request Form

Step 5: Under the Create tab and within the
Reports section, select Report Wizard.

e This will open the Report Wizard window. Here we can select which fields we would
like to populate the report.
Report Wizard

Which fields do you want on your report?

‘You can choose from more than one table or query.

Tables/Queries

Query: Outstanding Data Requests

Selected Fields: /

Step 5: To move all available fields into the
report, hit the double arrow to the right.

Available Field:

Requester's Name
Reguester's Department
Requester's Email




-
Report Wizard

Which fields do you want on your report?

You can choose from more than one table or query.

Tables/Queries Step 6: Remove Date Out, Completed By:,
Query: Outstanding Data Requests =] Hours to Complete:, Notes and File Location
Available Fields: Selectd Fiem:/ by selecting each and hitting the single left
Date Qut arrow. Then hit Next.

Completed By:

Hours to Complete:

Motes:

File Location

Requester's Name
Requester's Department
Requester's Email
Requester's Phone /

M W

Cancel [ Mext = l l Finish

Report Wizard

Do you want to add any grouping

levels? Req #, Date In, Due Date, Type,

Reguester's Name, Reguester's
Department, Requester's Email,
Reguester's Phone, Request Description,

Assigned To:, Notes:
=

. Step 7: We can group by specific fields in the
Requester's Name )
Requester's Department next step, but we do not need to for this

Regquester's Email Priority 3 .
Requester's Phone e report. Select Next without grouping.

Assigned To:

—

Cancel ] ’ < Back ]’ Mext = Einish ]

k

Report Wizard

What sort order do you want for your records?

‘You can sort records by up to four fields, in either
ascending or descending order.

=]
:

Step 8: We can sort by any field. Since this
is a report to view our outstanding data
requests, sort by Due Date, ascending, and
click Next.

Cancel || <Back | mext> || mnsh |




.

Report Wizard

How would you like to lay out your repart?

Layout Orientation

() Columnar i@ Portrait
= Tabular

€ -Landsca&
A ‘\

a page.

Step 9: Like in the Form Wizard, we will
use the Justified Layout and a Portrait

Adjust the fisld w Orientation.

Then click Next.

Cancel || <gack | mext> || @nsh |

e

.

Report Wizard

What title do you want for your report?

Outstanding Data Requests

That's all the information the wizard needs to org

=

xenuar

report.

Do you want to preview the report or modify thq
design?

(@) Preview the report.

() Modify the report's design.

Step 10: Title the report “Outstanding
Data Requests” and Click Finish to Preview
the Report.

Cancel ][ < Back ]

There is a lot of wasted space in the report.

We will need to format this report, like we formatted the Data Request Form.
We will first adjust the width of the fields to the appropriate size.
We will utilize the Layout View to do this, so let’s switch over to that view.




EHE S
HOME

&

REPORT LAYOUT TOOLS

Request Database SAIR14 : Database- R:\research\CONFER]

]E @ ' Show Margins

Size Margins

Print Data Only P!

Page Size
All Access Obje... @ «
Search.. el
Tables ES
BB Request Database
Queries 2

B Outstanding Data Requests
Forms

=]
Reports

B outstanding Data Requests

Data Request Form

iy
=l 2 )
ortrait Landscape Columns Page
Setup

Page Layout

I8 outstanding Data Requests

CREATE  EXTERNALDATA  DATABASETOOLS ~ DESIGN  ARRANGE  FORMAT  PAGESETUP
! E 7] Show Margins D = [%,
Size Margins [ | ping Data Only | POMrait Landscape Columns  Page
- - Setup
Page Size B Page Layout
All Access Obje... @ « fl outstanding Data Requests
Search.. yel
Tables # QOutstanding Data Requests
EA Request Database
Queries £ Due Date
=5 outstanding Data Requests 2/21/2014) Wl
Forms £ Req #
EE Data Request Form IR0016
Reports ES
Ml outstanding Data Requests . .
b ] — Step 11: Select the Date Fields and
1/16/2014 . . , .
fype manually adjust these fields’ width by
External
dragging their right border to the left.
Requester's Name
Kenny Kenneth Pigg
Requester's Department
Peterson's undergraduate survey
Requester's Ema
IR0016@uni.edu
Requester's Phone
2567650016
Request Description
Complete 2013-14 UG Survey
Assigned To:
mv/np
Due Date
3/7/2014
Req #
IR0017
B HE S & - REPORT LAYOUT TOOLS Request Database SAIR1A : Database- R:\research\CONFEREN!
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT PAGE SETUP

Outstanding Data Requests

DueDate |
2/21/2014]

1/16/2014
Type
External

Requester's Name

Kenny Kenneth Pigg

Step 12: Adjust the width of the fields Req#,
Type, Requester’s Name, Requester’s
Department, Requester’s Email,
Requester’s Phone, and Assigned To: to
appropriate sizes.

\

Requester's Department

Peterson’s undergraduate survey

Requester's Ema

IR0016@uni.edu

Requester's Phone

2567650016

[Request Description
Complete 2013-14 UG Survey

Assigned Tol

mvinp




HOME  CREATE

EBEHES @ - REPORT DESIGN TOOLS Request Database SAIRLA : Database- Ri\research\CONFERENCES\2014\5A

Table

All Access Obje... @
e

Tables

EH Request Database
Queries

B Outstanding Data Requests
Forms

EE Data Request Form
Reports

@ outstanding Data Requests

EXTERNALDATA  DATABASETOOLS  DESIGN ~ ARRANGE = FORMAT  PAGESETUP

Select Layout i 1o ‘EI [ O
olumn A € © D
Insert Insert Insert Insert - Merg Move Move —Control Control | Sizef Align Bring Send
Left  Right t Rov Up  Down Margins~ Padding - Spacer ~ toFront to Back
Rows & Columns Move Position Size
« || B outstanding Data Requests T Tofit
B e s ie s e ] ToTale ! B !
N € Report Header pra——
F Toorid
N - Size to Shortest
A € Page Header [ To widest
¥ Detail B, ToNarrowest
* ebate ] Spacing
* pue pate | oo Equal Horizontal

Increase Horizontal

o9 Decrease Horizontal
2 Equal Vertical

&1 Increase Vertical
2% Decrease Vertical
JF s Grid
. | Grid

F=| Ruler

1 snapto Grid
Grouping

siar’s Npme |
{|Requester's Name

Requesters DhparmentH ]
Requester's Department

+|H

o

REG e

Requester's Ema

REiEes Afiaris i

Requester's Phone

Step 13: Under the Arrange tab and within
| [[fecuestesrten the Size/Space pull-down, Select “To
Shortest”

ssigned To:

28
¥ Page Footer

=Now() ='Page " & [Page] & " of " & [Pages]

¥ Report Footer

EXTERMAL DATA

Totals

TOUP {5 Hide Details
Sort

Grouping & Totals
« || B Outstanding D
|

=
 Report Head

REPORT DESIGN TOOLS Request Database SAIR14 : Database- R:\resear]

DATABASE TOOLS DESIGN ARRANGE FORMAT PAGE SETUP

s @] Aa &M il BB

Controls

'ata Requests

L T T T T T T A T

er

- [Butets

¥ Page Header

Reguester's

Name Requester's Department
il - - :

Reguester's

Email

:|Request De

scription

Step 14: Arrange the fields as shown here.




BHEHOS & -
HOME CREATE EXTERNAL DATA DATAH

S T i’iii i Hide Detait L5 Step 15: Switch over to Print Preview to see
=] Reportview W—/ the report as is.

I o
@ i &7

t‘./ Design View quests

»

# Page Header
# Detail

ES] Data Request Form
Reports 2 |||-
@ outstanding Data Requests B P ime

= Requester's Name

Rad e star's B

- | |requester's Email

] — r‘
(REERERR Y <
| Tet PDF  Email More  Close Print
File orXPs - Preview
Data Close Preview
Qutstanding Data Requests
Peterson's undergraduate survey
| [Requester's Phone
2567650016
UG Survey
Saturday, September 27, 2014 Pagelof4

e There is still several areas that need formatting.

e To begin, we would like to have more than one outstanding request to be shown per page.
e Also, the header could be formatted to look better.

e  We will work on this next. Close the Print Preview.



e To allow more than one request to display per page, we will need to reduce the size of the
Detail section.

[} REPORT DESIGN TOOLS Request Database SAIRLA : Database- Re\rescarch\CONF|
CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT PAGE SETUP
- el s ~
Colors= |  Tota N = R X L .|
abl] Ag [ [7] €2 = B [EE] I @
roms- | GO {511 et T OR/MeE I\ = OV el | @1
& Sort
Grouping & Totah Contro
bje... © « | ovsanarg oo e
- 1 2 9 0 5 8 7 8

ta Request -
Wi i il i [Tk T
Ml Due Date Date In \Assigned To:| .

N : Step 16: Click on the Rectangle
h [:lRequester's Department sl . . .
_ e T ; surrounding the detail fields.
.
B
|
;
.
,
: [Nowi) i i "Page " & [Page] &" of " & [Pages||

) o BT e Dot SAFL: Db e COM
GATE  OTCNALDATA  DATABASETOOLS  DESGN | ARMANGE  FORMAT  PAGESETUP

B fir i Step 17: Pull up the bottom of the
ShEE : ! : / rectangle until it is close to the
bottom of the Request Description.

# age Foote:

| [enow() "Page " & [Page] & " of " & [Pages]




@ = REPORT DESIGN TOOLS
REATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT

Rows & Columns Merge / Split

%) « || I8 Outstanding Data Requests

Request Database SAIR14 : Database- R\research\CONFEREN

o

3€
Size/
Space~

Sizing & Ordering

Request Description

P T T T N T

L

= # Report Header

- [Bitstanting Baty Reqiesrs

# # Page Header
quests # Detail

N T T T T

- Rew i ] Dusibate: i Dateiln: g Fype ssighad:

:||Due Date Date In i Type \Assigned To:

" E FEEREEEHH FF :

Step 18: Hover over the top of the
Page Footer border, Left-click and

drag it up to just below the bottom
of the rectangle.

' L~

=Now()
# Report Footer

="Page " & [Page] & " of " &[Pages]”

Qutstanding Data Requests
[ Dat

RO016 1/16/2014| |[External

Requester's Name s Department ‘
Kenny Kenneth Pigg Peterson's undergraduate survey
Req sEmai | |3‘e: s

RO016& uniedu 2567650016

Complete 2013-14 UG Survey

Step 18: View the Print Preview.

Now there are 2 requests per page.
If we could create a bit more room,
we could fit 3 requests per page.

Req # | e e |Datein | [Tvee

IRDO17 3/7/2014) 1/16/2014| |[External h
Requester's Name \
Kenny Kenneth Pige Peterson's financial aid

Requester's Emai | |:!e:|-_|e;—.e-' < Phone

IRDO16@ uniedu 2567650017

Request Description

Get information from SFS

Saturday, September 27, 2014

Page 1 of 2




REPORT DESIGM TOOLS

ATE EXTERMAL DATA DATABASE TOOLS FORMAT

[ @bl Ag = [7]

DESIGM ARRAMNGE

B, XY E ’% EE

ATH,

| Group ji5 Hide Details
& Sort

Request Database SAIR14 : Database- R\research\ CONFERENCES\2014
PAGE SETUP

N\ B EO

| Requester's Department

Grouping & Totals Controls
@ « I8 outstanding Data Requests
R - I ' B B - ' - ' T ' -2 ' B

yel

% # Report Header

ES
uests

I’

. i||pue

Due Date Date In

ES

uests

Requester's Email Reguester's Phone
- I

Request Description

# Page Footer

=Now()
# Report Footer

[
="Page " & [Page] & " of " & [Pages]|

Step 19: Switch to Design View a
arrange the fields as shown abov

nd
e.

e Switch back to Print Preview

BmELHYE B8

Excel Text PDF Email More  ClosePrint
File orXPS M Preview
Data Close Preview
O ta Requests

utsta

nding Da

We now have 3 requests on page 1
and 1 remaining request on page 2.

iea®

1RO
[

Tpoeo=e

3/7/2014|

TTosen [ oee
1/16/2014) External

n

Requester'sName
Kenny Kenneth Pigg

F= | Reauesters ema

IRO016@unit edu

| Fequester=phone |
2567650017

s Department
Petersors financial ad

=

Get information from SFS

on

Extermal

Saturday, September 27, 2018 Page1or2




e We now need to format the Header, so switch back to Design View again.
F o~ @ - REPORT DESIGN TOOLS Request Database SAIR14 : Database- R\research\CONFERENCES\2014\SAIR\Access W]
HOME CREATE EXTERNAL DATA DATABASE TOOLS DESIGN ARRANGE FORMAT PAGE SETUP

] &

Themes

mes [&] Fonts ~

olors ~ Totals
Graup {9 Hide Details
& Sort o

Grouping & Totals

bss Obje... ® «
el

it Database

»

nding Data Requests

equest Form

@ outstanding Data Requests

%Aar_ﬁ

ey

-

MeEaNEBOV W0

Controls

D A

& Report Header

# Page Header
# Detail

[Bue Gt

nding Data Requests

Request Description

Step 20: Select the Text Box within
the Header and manually center it.

| Requester's

# Page Footer

+|[Fown)
# Report Footer

="Page " & [Page] & "of " & [Pages]

Step 21: Switch back to Layout

View.

REPORT LAYOUT TOOLS
ARRANGE

Request Database SAIR14 : Database- Ri\research\CON|

S

DESIGN FORMAT PAGE SETUP

=

Background _Altemate
mage -
Background

Row Calor

Conditional

Cantrol Formattit

Step 22: Select the Header and
change the background to White.

B HE S Q-
HOME ~ CREATE  EXTERNALDATA  DATABASE TOOL!
1 |ReportHeader ~
=1} Select All D~
Selection Fo Autematic
@ Theme Colors
= «
All Access Obje... E mEEs-E
Search.. yel [}
Tables 2
EH Request Database I
i (11§

Queries
B Outstanding Data Requests

lard Colors

. H EEEEEN
Forms 2
-
E= Data Request Form White
Reports 2 ]|
[l outstanding Data Requests EEEEENN

H

‘éeq.les:ers Department

Peterson's undergraduate survey

Outstanding Data Requests

[patein | [rvee

1/16/2014| |[External

| |Assigned To:|

mv/np

| ‘i.eq.les:ers Emai
IR0016@uni.edu

‘ ‘éques:erS Phone ‘

2567650016

EEEEEEEEENy

# More Colors...

Req#

IR0017

| |pue ate

3/7/2014)

|pate In | [Tvee
1/16/2014| |External

| |assignedT]

Ih

Step 23: Switch back to Layout

View.

E,, »

T tsbetn

B Iy

Step 24: Select the text box within
the Header and change the font
color to Black and Underline the
text.




e (Creating additional reports similar to the Outstanding Data Requests report is very simple.

e Let’s say that we want to create a report that looks at all of the reports completed by a certain
user, labeled as “np”, within the month of February of this year.

e We can create a query with these parameters and modify the existing report to pull from that

query.

e First, let’s create the query.

2] ©- @ -
HOME | CREATE

@ EH&

Application  Table Table SharePoint Query Query
Parts Design ~ Lists -

Templates Tables

All Access Obje... ©
Search.

Tables

EH Request Database
Queries

51 outstanding Data Requests
Forms

F@ Data Request Form
Reports

@ outstanding Data Requests

«

el

EXTERNALDATA  DATABASE TOOLS
D m iom| m D [ Form Wizard j |J j {3 Report Wizard h £ Module
= i i H
X [ Navigation ~ Labels L% Class Module

orm  Form  Blank

Wizard Design
Queries Forms
Query Design

Create 2 new, blank query in
view

Vou can then use the Show Table
dialog bex to add tables or queries
to the query design.

Request Database SAIR14 : Database- Ri\research\CONFERENCES\2014\SATR\Access Workshop\Request Database
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Step 1: Under the CREATE tab, and
within the Queries section, select
Query Design.
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Step 2: Like before, bring all fields
into the query.

Step 3: Type >=#2/1/2014# and
<=#2/28/20144 in the Criteria
line under the Date Out field.
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Step 4: Type Like “*np*” into the
Criteria line under the Completed
By: field.
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When you run the query, you’ll see that
there were 2 reports completed by “np”
within the month of February.

e This may be interesting data, however a more useful report may be to look at all reports
completed in the past X number of days.

e We could create a report that looked at all requests completed in the past 30 days, for example.
However, since our data set’s dates out are between Nov. 2013 and February 2014, that query
would return zero records.

e We will modify the formula to look at requests completed within the past 250 days.
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Step 6: Remove the criteria Like
“ ”
*np*” under the Completed By:
field.
4
J
Field: |Reqg# Date In Due Date Date Out Type Requester's Name Requester's Departme Reques
Table: |Request Database Request Database Request Database Request Dgtabase Request Database Request Database Request Database Reques
Sort:
Show:
Criteria: »Date(-250

Step 7: Run the query to view the
results.




@ s Request Database SAIRL4: Database- R\research\ CONFERENCES\2014\SAIR\Access Workshop!\Request Database SAIR14.accdb (Access 2007 - 2013 file format) - Access
EXTERNALDATA  DATABASETOOLS

A As o+ i s 2
Y 2| Ascending s Selection ENew 2 Totals IH) BeReplace [0 mm
& B

%l Descending T Advanced + Hsae 7 speling 3 GoTor

Fit P’ZT,[‘EEI" X Delete + EMore~ find [ Select~ BTIU A &- 4 =
G Sort & Filter Records Find Text Formatting ]
o «|| = Recently Completed Data Requests { B3 Request Database
Dateln - DueDate - DateOut -  Type - Requester's - Requester's - Requester'sEmail - Requester's - RequestDet - AssignedTo - Completed |- HourstoCor~| Notes: - File Locatior «
:D 12/20/2013 2/14/2014 2/7/2014 Internal Tina Jones Distance Learn IR0013@uni.edu 2567650013 Fall 2013 Onlin np np 10
= 12/20/2013 2/14{2014 2/10/2014 Internal Dr. Helio OIRPA IR0004@uni.edu 2567650014 Fall 2013 Cours np np 40
1/8/2014  1/23/2014  1/31/2014 Internal PeterParker  Nursing IR0015@uni.edu 2567650015 A list of Nursin mv. mv 2
A 1/16/2014 3/7/2014 3/7/2014 External PhillipSuage  CSRDE IR0018@uni.edu 2567650018 Main retention mv my 6
¢ 1R0021 2/6/2014 2/6/2014 2/6/2014 Internal Muscles Malon Athletics IR0021@uni.edu 2567650021 GPA of athletic mv my 0.002 athletes =2.75
e IR0022 2/3/2014 2/7/2014 2/7/2014 Internal DeanStone  Nursing IR0022@uni.edu 2567650022 Number of grai mv. myv 1
% IR0023 2/7/2014 2/7/2014 2/7/2014 Internal Pearl Blutooth Judicial Affairs IR0023@uni.edu 2567650023 List of Majors  mv. my 0.2 Included level
1R0024 2/7/2014 2/7/2014 2/7/2014 Internal President Phill President's Off IR0024@uni.edu 2567650024 Update housin, mv. mv 02
s IR0025 2/7/2014 2/7/2014 2/7/2014 Internal HelloKitty ~ EdTech IR0007@uni.edu 2567650025 Number of phy mv. mv 0.005 The number s
s 1R0026 2/10/2014  2/10/2014  2/24/2014 Intemnal Bobby Charles Music IR0026@uni.edu 2567650026 Spring 2014 Mu mv.
*

e All requests completed within the past 250 days are displayed.
e We should save this query and create a report based on this data.

e Keep in mind that if you utilized this query at your institution and wanted to look at the requests
completed in the past 30 days, simply replace 250 with 30 in the formula above.

Step 8: Save the query as Recently Completed Data Requests and close the query.

e Instead of creating a report from scratch, as we did before, let’s modify the existing report to
display our recently completed requests.

Step 9: Open the report Outstanding Data Requests in design view.
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Step 11: In the Record Source line
of the Property Sheet, change the
source to Recently Completed Data
Requests.
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Step 12: Select Save As and name
the report Recently Completed
Data Requests.

Step 13: Select Print Preview to see
the results of our new report.

e There are a couple of changes that need to be made to the report, though most of the work is
done.
e Of course, we need to change the title in the Header.
e We also need to include a couple of fields that were omitted from the Outstanding Data
Requests report.
0 We need to include the fields Completed By: and Hours to Complete. We could also
include the Notes field and File Location fields, if we would like.
e Close the Print Preview and switch over to Design View.
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Step 14: Replace the text in the
Header to read Recently Completed
Data Requests.
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To add the fields Completed By and Hours to Complete, follow the steps below.
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Step 15: Under the Design tab,
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select the Text Box option.
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Step 16: Drag open the text box to
the right of Assigned To.
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e You'll notice that the text box that reads “Text26” is to the left of the data text box you just

created. To place the text box above the data box, grab the box in the top left corner of the text
box and pull the text box over and above the data text box.
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Requester's Name
Requester's Department
Requester's Email
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Request Description
Assigned To
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Step 18: To map the data text box
to data found within the Completed
By field, Click only on the data text

box. Step 19: In the Data tab, within the
Property Sheet, pull down the
options for Control Source and
Select “Completed By:”

Merge / Split Move Pasition 5izing & Ordering

quests

:|Requester's Department ;| Requester's Email :|Requester's Phone

Step 20: Change the text box above
to read “Completed By:”. You will
need to increase the width of these
text boxes.

Step 21: View the Report




Sort & Filter Records Find Text Formatting
Eﬁ Outstanding Data Requests

Recently Completed Data Requests

[Req # | [puepate | |Datein | [rype | |assigned To:| Completed By:

IR0015 1/23/2014 1/8/2014| |Internal mv mv

|=.eq.1-as:er's Name | Requester's Department | |:.eq.4-as:er's Emai | Requester's Phone |
Peter Parker Nursing IRO01L5@uni.edu 2567650015

|?:eqjes: Description |

A list of Nursing majors - name, ethnicity, GPA.

[Req # | [puepate | |Datein | [Tyee | |assignedTo:| Completed By:

IR0021 2/6/2014) 2/6/2014| |Internal my my

|=:-aq.1es:er's Name | Requester's Department | |::eq.1es:-ar's Emai | Requester's Phone |
Muscles Malone Athletics IR0021@uni.edu 2567650021

|::-2q.1»"_5: Description |
GPA of athletics vs non-athletes f13 undergrads

|=.eq= | |3.le Date | |3a:e n | Type | ‘Ass'g’uech: Completed By:

IRO022 2/7/2014) 2/3/2014| |Internal mv my

|?:eqjes:er's Name | Requester's Department | |::quester's Emai | Requester's Phone |
Dean Stone Mursing IRD022@uni.edu 2567650022

|=:-2q.1es: Description |
Number of graduates by divisio 2008-2013

e We now see that the report contains the field displaying the person that completed the request.
However, the text box above does not have a border surrounding it. We can change this in that
text box’s property sheet.

e Switch back to Design View.
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e When you view the report now, the border for the text box will be visible.
e lastly, we need to add a text box displaying the information for the field Hours to Complete.
e We will use another method to add this box.
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Step 28: In the Property Sheet’s
Data tab, change the Control
e & (ool & ot & poge| Source from Completed By: to

Hours to Complete:
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Step 29: Type Hours to
Complete: in the text box.
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e Save the report and view it in Print Preview.
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Recently Completed Data Requests
|Req # Due Dae Dateln Type Assgned To: | [Completed By: | [Hoursto Complete:
|IHDE!15 1/23/2014 1/8/2014| |Internal mv mv 2
Requester's Name Requester's Department Requester's Emai Requester's PFhaone
Peter Parker Nursing IRO01S@uni.edu 2567650015
Request Description

A list of Nursing majors - name, ethnicity, GPA.

|Req# Due Date Dateln Type Assgned To: | [Completed By: | [Hoursto Complete:
[IRD021 2/6/2014 2/6/2014| (Internal mv mv 0,002
Requester's Name Requester's Department Requester's Email Requester's Phone
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Request Description
GPA of athleticsvs non-athletes f13 undergrads
|Req# DueDae Dateln Type Assigned To: | [Completed By: | [Hoursto Complete:
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MNumber of graduates by divisio 2008-2013
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Thank you for attending. If you need any additional

information or help, please feel free to contact either
of us:

Nathan Pitts — ; (256) 765-4954
Molly Vaughn — ; (256) 765-4343
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